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Abstrakt 

Tato práce se zabývá  bezdotykovým měřením teploty, jeho principy a rozdělením. 
Je zaměřena především na termovizi. Dále je zde proveden popis termokamery SH-68 / HY-
6800, popsána její funkce a vybavení. K projektu je zpracován stručný manuál s důležitými 
informacemi pro měření a s příkladem jednoduchého měření rozepsaného do několika kroků. 
Další část je zaměřena na současné využití termovize. Poslední část je věnována měření oteplení 
proudovodné dráhy VN odpínače termokamerou a jeho  porovnání s dotykovou metodou měření 
teploty. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Abstract 

This work deals with contactless measurement of a temperature, its principles and types. 
Above all, it is aimed mainly on thermovision. Infrared camera SH-68 / HY-6800 is  presented 
and its functions are described. Brief instruction manual together with important information on 
a measurement is also presented. An example of a simple measurement, which is itemized to 
several steps, is worked up in the framework of the project. The last part of the project is devoted 
to the thermovision applications in a general practice. Temperature rise of a part of high voltage 
diconnector was measured by IR camera and compared to the contact method of the temperature 
measurement. 
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1 ÚVOD 
 

Tato práce se zabývá bezdotykovým měřením teploty. Teplota je jedna z nejdůležitějších 
termodynamických vlastností, které určují stav hmoty, a objevuje se v mnoha fyzikálních 
zákonech. Existuje jen velmi málo vlastností látek, které by nebyly teplotně závislé. Ve své 
podstatě je teplota mírou kinetické energie pohybu molekul a atomů, přičemž molekuly na sebe 
navzájem narážejí a rychlost jejich pohybu se stále mění v čase. Za nejnižší teplotu se pokládá 
absolutní teplotní nula, neboli nula termodynamické stupnice (0 K), během níž veškerý pohyb 
ustává. Pro stanovení teploty se používají teplotní závislosti jiných fyzikálních veličin. Volí 
se takové fyzikální jevy, u nichž lze závislost veličiny matematicky vyjádřit teplotní stupnicí.  

Znalost teploty je nutná ve všech oblastech lidské činnosti. Jednou z prvních aplikací 
teploměru byl lékařský teploměr (vynalezen roku 1866). Diagnostika ale není jen lékařská 
disciplina, ale také základní prostředek ke zjišťování technického stavu neživých objektů. 
Základem bezpečnosti, spolehlivosti v energetice, v letecké, železniční, automobilové dopravě 
a ve veškeré průmyslové produkci elektrospotřebičů, výpočetní a telekomunikační techniky 
je technická diagnostika. Přičemž měření teploty patří mezi základní diagnostické veličiny.  

Současný trend v teplotních senzorech spočívá v širším využití mikroelektronických 
technologií jako např. v implementaci polovodičových čidel teploty na jediný čip s analogovými 
a číslicovými obvody umožňující připojení senzoru k signálovým sběrnicím, ve vývoji nových 
typů detektorů tepelného záření, v integraci teplotních čidel do inteligentních (tzv. smart) senzorů 
libovolných fyzikálních veličin pro automatickou korekci odchylek parametrů způsobených 
kolísáním provozních teplot aj.  

Mezi nedílnou součást moderního bezdotykového měření patří termovize. Jejímž principem, 
vlastnostmi a aplikačním využitím se budu převážně zabývat. Zaměřím se především na výhody, 
které přináší oproti jiným způsobům měření, na obsluhu takovéhoto zařízení a zajištění všech 
náležitostí potřebných pro přesnou diagnostiku. Dále se budu zabývat praktickým využitím 
termovize v soušastnosti. Poslední část práce se bude zabývat praktickým měřením 
termokamerou. 
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2 ZÁKLADNÍ POJMY  

2.1 Teplota 
Teplota je stavová veličina určující stav termodynamické rovnováhy. To je stav, kdy 

v izolované soustavě těles od okolního prostředí neprobíhají žádné makroskopické změny 
a všechny fyzikální veličiny, jimiž je stav soustavy popsán, nezávisejí na čase. Stav 
termodynamické rovnováhy bývá charakterizován termodynamickou teplotou, která musí být 
stejná pro všechny části izolované soustavy. Teplota je jedna z mála veličin, která se nedá měřit 
přímo, ale pouze prostřednictvím jiných fyzikálních veličin. Měření teploty je tedy měření 
nepřímé.[2] 

2.2  Černé těleso, černý zářič 
Černé těleso je těleso, které dokonale pohlcuje dopadající záření, a to při každém dopadu 

při libovolné spektrální záři a které naopak při každé vlnové délce vyzařuje maximální energii 
nezávisle na použitém materiálu. Záře černého tělesa je ve všech směrech v poloprostoru nad 
zářičem konstantní. Emisivita černého tělesa 1=ε . Pro kalibraci pyrometrů se používá tzv. černý 
zářič, jehož emisivita ε ≈ 1. Černý zářič má hodnotu emisivity v rozmezí 99.01 >> ε . Obvykle 
se realizuje tzv. dutinovým zářičem s reflexním, difuzním nebo difuzně reflexním povrchem. 
Černý zářič je zdrojem záření pro kalibraci všech typů pyrometrů.[2] 

        

2.3  Senzor teploty 
Senzor teploty je funkční prvek tvořící vstupní blok měřícího řetězce tj. blok, který 

je v přímém styku s měřeným prostředím. Pojem senzor teploty je ekvivalentní pojmu snímač 
teploty (samostatná konstrukční součást teploměrového zařízení, která obsahuje teplotní čidlo), 
ale také pojmu čidlo teploty (část snímače převádějící teplotu na jinou vhodnou fyzikální 
veličinu). Stejně tak se jako senzor označuje detektor tepelného zařízení nebo teploměr (zařízení 
k měření teploty).  

• Dle fyzikálního principu se senzory teploty dělí na odporové, termoelektrické, 
polovodičové s PN přechodem, dilatační, optické, radiační, chemické, šumové, 
akustické, magnetické a na další jako jsou např. kapacitní, aerodynamické. 

• Dle styku s měřeným prostředím se senzory teploty dělí na dotykové a bezdotykové. 

• Dle transformace signálu se senzory teploty dělí na aktivní, které se působením 
teploty chovají jako zdroj elektrické energie (termoelektrické články) a na pasivní, u 
kterých je s výjimkou chemických indikátorů teplot nutné elektrické napájení pro 
transformaci teploty na jinou fyzikální veličinu, neboť měření teploty je vždy 
měřením nepřímým.[2] 
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3 BEZDOTYKOVÉ M ĚŘENÍ TEPLA  
Bezdotykové měření teploty (také označované jako infračervená pyrometrie) je měření 

povrchové teploty těles na základě vysílaného elektromagnetického záření tělesem a přijímaného 
senzorem (detektorem) záření vlnové délky od 0,4 µm do 25 µm. Rozsah pokrývá oblast 
viditelného spektra od 0,4 µm do 0,78 µm, oblast blízkého červeného spektra od 0,78 µm 
do 1 µm, oblast krátkovlnného infračerveného spektra od 2 µm do 3 µm, oblast středovlnného 
infračerveného spektra od 3 µm do 5 µm a konečně oblast dlouhovlnného infračerveného spektra 
od 5 µm do 25 µm. Elektromagnetické záření s vlnovou délkou od 2 µm do 25 µm se označuje 
jako tepelné záření. Uvedené rozsahy pokrývají měření teplot v rozsahu od -40 °C 
do +10 000 °C. 

3.1  Výhody bezdotykového měření teploty 
• zanedbatelný vliv měřicí techniky na měřený objekt 

• možnost měření teploty na rotujících nebo pohybujících se objektech 

• měření teploty z bezpečné vzdálenosti (elektrická zařízení, hutní objekty aj.) 

• možnost měření velmi rychlých změn teploty 

• možnost měřit a dále číslicově zpracovat teploty celých povrchů těles (tomografie, 
termovize) 

3.2 Nevýhody bezdotykového měření teploty 
• nejistoty měření způsobené neznalostí správné hodnoty emisivity povrchu tělesa 

• nejistoty měření způsobené neznalostí správné hodnoty prostupnosti prostředí mezi 
čidlem a objektem 

• nejistoty měření způsobené nepřesnou korekcí parazitního odraženého záření z okolního 
prostředí na měřený objekt  

 

Rozdíl mezi dotykovým a bezdotykovým měřením teploty je zřejmý z Obr.3.1: Při 
dotykovém měření, např. termoelektrickým článkem, dochází k akumulaci dvou nejistot měření. 
Jednak zářivý tok Ф proudící do vodičů termoelektrického článku způsobí deformaci izoterm 
v měřeném místě tělesa a jednak vznikne teplotní rozdíl způsobený zářivým tokem Ф 
na stykovém tepelném odporu mezi snímačem teploty a tělesem. Hodnoty těchto nejistot mají 
stejné znaménko, takže se jejich účinek sčítá.[2] 
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Obr. 3.1: Izotermy teploty v tělese a okolí při měření dotykovým snímačem 

3.3 Tepelné detektory infračerveného záření 
U tepelných detektorů dochází při absorpci fotonů k oteplení citlivé části detektoru. Pohlcená 

energie se vyhodnocuje nepřímo prostřednictvím snímačů teploty. Tepelné detektory se dělí na: 

• termoelektrické 

• bolometrické 

• pyroelektrické 

3.3.1 Termoelektrické detektory  
Termoelektrické detektory záření neboli tzv. termoelektrické baterie jsou sériově řazené 

termoelektrické články, které jsou konstruovány buď jako tenké kovové pásky tl. cca 0,03 mm 
nebo jako pásky zhotovené technologií tenkých vrstev nebo Si technologií. Jako termoelektrické 
materiály se používají klasické normované typy termoelektrických větví, ale také materiály jako 

např. Bi, Sb dopované Se a Te s termoelektrickým koeficientem až 230 1−⋅ KVµ   

3.3.2 Bolometrické detektory  
Bolometrické detektory záření snímají oteplení detektoru teplotně závislým odporovým 

materiálem tj. pohlcené záření způsobí změnu teploty odporového čidla a tím i změnu jeho 
elektrického odporu. Používají se tenkovrstvé mikroelektronické technologie na bázi odporových 
materiálů z kysličníků MgO, MnO, NiO, aj. Mikrobolometrické senzory lze uspořádat jako 
řádkové nebo plošné detektory. Plošné detektory se používají v termovizních kamerách 
v maticovém uspořádání FPA (Focal Plane Array). Matice obsahují 240320×  až 480640×  
elementů.  

3.3.3 Pyroelektrické detektory 
Pyroelektrická záření jsou založeny na pyroelektrickém jevu, tj. změně spontánní polarizace  

při změně teploty. Pyroelektrický jev se vyskytuje u pyroelektrik s trvalou polarizací nebo               
u některých feroelektrik, u nichž se orientace domén vytvoří silným elektrickým polem.[2] 
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4 TERMOVIZE  
Termovizní systémy se dělí na: 

• termovizní systémy s opticko-mechanickým rozkladem obrazu 

• termovizní systémy s maticovým detektorem 

Opticko-mechanický rozklad obrazu se realizuje snímáním jednotlivých bodů objektu 
řízenou optickou osou. Okamžité zorné pole termovize se postupně zaměřuje na všechny body 
(plošky) měřeného objektu. Dráha rozkladu se provádí pohyblivými optickými částmi kamery 
(otočné hranoly nebo zrcadla). Výroba těchto systémů pro civilní účely už skončila. 

Pro termovizní kamery se nyní používají chlazené a nechlazené maticové mikrobolometrické 
a kvantové (QWIP) FPA detektory (1 D-řádkové a 2D-plošné). Chlazení FPA matice se provádí 
Stirlingovým chladičem (hermeticky uzavřený chladicí systém se dvěma písty s plynným heliem, 
pracující na principu kompresorové mikrochladničky) nebo termoelektrickým chladičem. 
Zpracování signálů je realizováno přímo na čipu prostřednictvím multiplexorů a 14bitových A/D 
převodníků v každé řádce matice. Programové vybavení dodávané k termovizím umožňuje kromě 
základního nastavení parametrů různé způsoby zpracování signálu, jako je vykreslení teplotního 
profilu v libovolném místě obrazu, vyhodnocení střední a maximální hodnoty teploty ve zvolené 
oblasti obrazu, vyhodnocení teploty v libovolném místě na obraze, barevné zobrazení zvolených 
izoterm, nastavení různých hodnot emisivit na zobrazeném objektu, změnu barevné palety aj. 
V termovizní technice se používají dvě hlavní pásma vlnových délek, krátkovlnné (2 µm 
až 5 µm) a dlouhovlnné (7 µm až 13 µm). Prostřednictvím amplitudového diskriminátoru 
videosignálu lze u termovize nastavit pro libovolné rozmezí teplot libovolnou barvu nebo alespoň 
zvolit některou z volitelných barevných palet. Je nutno si uvědomit, že termovize pracuje 
v neviditelném spektru záření, kde žádné barvy neexistují, takže přiřazení barev je umělé. 

Termovize je základním měřicím zařízením pro infračervenou diagnostiku. Na základě 
znalosti rozložení teplotního pole diagnostikovaného objektu lze kontrolovat funkce zařízení, 
jejichž činnost je spojena s vývinem nebo absorpcí tepla. Lze tak lokalizovat různé materiálové 
vady, opotřebení způsobené třením (např. u ložiska) a jiné takové defekty vnitřních dílů objektu, 
které ovlivňují rozložení povrchové teploty. 

V energetice je možné např. diagnostikovat pod vysokým napětím za provozu izolační stavy 
izolátorů, spojovacích svorek kontaktů, stavy vypínačů aj., v elektrotechnice sledovat teplotu 
pláště elektromotoru atd. Existují dvě metody, které umožňují diagnostikovat i defekty uvnitř 
materiálu, a to jsou: Pulzní termografie, lock-in termografie.[2] 

 

4.1  Stanovení hodnoty emisivity  
• použitím vhodných tabulek  

• teplota objektu se nejprve změří dotykovým snímačem a pak se po zaměření objektu 
pyrometrem nastaví emisivita na takovou hodnotu, aby pyrometr ukázal předem změřenou 
teplotu; nastavená hodnota je pak správná hodnota emisivity povrchu tělesa 

• část povrchu objektu lze začernit speciální vrstvou laku nebo sazí se známou hodnotou 
pohltivosti; po změření správné teploty připravené plochy zaměříme pyrometr na jinou část  
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plochy a další postup je obdobný jako v předcházejícím případě. Do objektu, pokud je to možné, 
vyvrtáme otvor, jehož hloubka bude alespoň 6x větší než průměr; průměr otvoru musí být větší 
než je průměr terče stanovený optikou pyrometru pro danou vzdálenost; při měření teploty 
v otvoru nastavíme emisivitu pyrometru na hodnotu 1=ε ; podmínkou je, aby teplota tělesa byla 
v otvoru stejná jako na povrchu, jinak se postup opakuje 

• emisivitu vzorku materiálu lze změřit spektrometrem [2] 
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5 TERMOVIZNÍ KAMERA SH-68 / HY-6800 

5.1  Představení 
Uživateli poskytuje nejen infračervený obraz, ale také jeho bodovou, lineární a zónovou 

analýzu, a také hlasovou poznámku, kterou je možné nahrát v místě vytvoření snímku. Výsledný 
snímek můžeme uložit na paměťovou kartu a později ho na PC upravit v programu SatReport 
Standard, dále jen SRS. 

Kamera je vybavena nechlazeným FPA senzorem, je prachu a vlhku odolná, má vysokou 
teplotní citlivost a rozlišení, menu ve stylu Windows a provedení  na obsluhu jednou rukou. 

5.2  Popis částí termokamery 
 

 

Obr. 5.1: Popis částí kamery 

1. tělo kamery 

2. infračervený objektiv 50 mm – zaostřuje měřené infračervené záření na teplo-citlivý 
senzor FPA 

3. hledáček 

4. ovládací tlačítka 

5. baterie 

6. paměťová karta 

7. kryt prostoru pro baterii a paměťovou kartu 
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5.3  Ovládací tlačítka 
 

 

Obr. 5.2: Ovládací tlačítka 

 

5.3.1 Tlačítko     " ↵↵↵↵" - Menu / Potvrzení 
Jeho hlavní funkcí je vyvolání hlavního menu, vstup do submenu a potvrzení zvolené funkce. 

V normálním režimu se po stlačení tlačítka zobrazí hlavní menu. Termokamera tak přejde 
do tzv. „menu“ režimu. 

V menu režimu tlačítky „L“ a „R“ se listuje horizontálně mezi jednotlivými skupinami, 
tlačítkem "-" se zobrazí vertikální submenu skupiny. Po nalistovaní požadované volby pomocí 
„L“  a "R" tlačítkem "↵" potvrzení. Pokud se daná volba dále člení, zobrazí se příslušné submenu, 
jestli ne, vyvolá se příslušná funkce. 

 

5.3.2 Tlačítko " A" - Automatické nastavení 
V normálním režimu, t.j. při zobrazení infračerveného snímku objektu se stlačením tlačítka 

aktivuje automatické nastavení úrovně jasu a kontrastu podle aktuální scény cílového objektu. 
Nastavení je možné opakovat i vícekrát, než se dosáhne optimálních pozorovacích podmínek. 

Při probíhající analýze se stlačením tlačítka analýza pozastaví. Tím se „uvolní“ směrová 
tlačítka „+“, „-“, „ L“  a „R“  a opět  je nimi možno ovládat zaostření a zvětšení či zmenšení 
obrazu. 

5.3.3 Směrové tlačítka „ L“ , „ R“ , „+“,  „-“ 
Tyto tlačítka je možné chápat ve významu vlevo, vpravo, nahoru a dolů. Využívají 

se na listování v menu, přesouvaní bodů, čár a ohraničení zón v módu analýzy, na zvětšení 
a zmenšení obrazu, přechod do 4-snímkového zobrazení a zaostření. 

 V režimu menu tlačítky „L“ a „R“ se nalistuje hlavní skupina menu volba se potvrdí 
tlačítkem "↵ ".Pomocí tlačítek „L“ a „R“ se prochází jednotlivými položkami, tlačítky „+“ a „-“ 
se změní hodnota zvoleného parametru. 
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V normálním režimu, se kromě použití automatického nastavení rozsahu pomocí tlačítka „A“ 
dá použít i kombinace tlačítek „C“  + směrové tlačítko na manuální nastavení hodnot jasu 
a kontrastu: 

 

„C→+“, „ C→ -“  - nastavení úrovně jasu 

„C→L“ , „C→R“  - nastavení kontrastu 

 

 

5.3.4 Tlačítko „ C“ - Zrušení/Návrat 
V menu režimu se po stlačení tlačítka vrátí kurzor zpět do předešlé úrovně menu, 

opakovaným mačkáním se postupuje až po ukončení menu a návrat do normálního režimu. Toto 
tlačítko neukládá předešlý výběr volby v submenu. 

 

 

5.3.5 Tlačítko „ S“ - Pozastavení/uvolnění obrazu 
Krátkým stlačením tlačítka se střídavě pozastaví a uvolní živý obraz. Přidržením tlačítka 

se aktuální snímek uloží na paměťovou kartu. 

V režimu „PC Card read“ stlačením tlačítka se opustí tento režim a obraz se vrátí zpět 
do reálného měření. 

5.4  Příslušenství 
 

• 2 ks Li-Ion baterií 

• Nabíječka s adaptérem 

• Kabel video signálu 

• Konektor video 

• Audio sada- sluchátka s mikrofonem 

• Paměťová karta 128MB 

• PCMCIA adaptér pro paměťovou kartu 

• Kryt infračerveného objektivu 

• Řemínek na kameru 

• Programové vybavení  

• Přenosný kufřík 
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6 STRUČNÝ MANUÁL  

6.1 Základní ovládání 

6.1.1 Příprava k měření, upozornění 
Před použitím kamery zkontrolujte, zda je v ní baterie a paměťová karta. 

Nemiřte zbytečně dlouho kamerou na příliš horké zdroje, jako jsou Slunce, svářecí oblouk 
atd. Může to zničit citlivé senzory kamery. 

 

6.1.2 Zapnutí přístroje 
Zmáčkněte vypínač a zapněte kameru. V průběhu startu se v hledáčku zobrazují barevné 

pásy s logem výrobce. Po cca 30-ti sekundách se v pravé části displeje ukáže teplotní měřítko 
a v dolní části informační řádek. Start kamery je ukončen. Odstraňte kryt objektivu a zaměřte 
objektiv na cílový objekt. V hledáčku uvidíte infračervený obraz objektu. 

 

6.1.3 Výpisy při startu 
„ Initiating PC Card“- Paměťová karta byla rozpoznána 

„ Initiation Failure“- Paměťová karta nebyla rozpoznána (je nutné kartu vložit nebo vyjmout 
a znovu vložit)  

Poznámka: Kartu lze vložit kdykoliv v průběhu měření, bez karty je v menu „File“ dostupná 
jen volba „Voice rec“, všechny ostatní jsou zakázané. 
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6.1.4 Informa ční panely 
Po zapnutí a úvodní inicializaci zařízení se zobrazí standardní obrazovka. Na ní je umístěno 

několik informačních panelů: 

 

Obr. 6.1: Informační panely 

6.1.5 Měřítko teplotního rozsahu 
Měřítko teplotního rozsahu je zobrazené v pravé části obrazu. Barevný pás reprezentuje 

jednotlivé teploty. Nejvyšší a nejnižší teplota je zobrazená nad, resp. pod měřítkem. Rozsah 
měřítka se mění v závislosti na změně barevné palety a nastavení rozsahu měření. 

 

6.1.6 Informa ční řádek 
Informační řádek se nachází na spodním okraji displeje. Je rozdělený do několika sekcí  

s následujícím významem: 

a) sekce - aktuální režim 

Jak  je možné vidět na obrázku Obr.6.1: „Null“ znamená, že není vykonávána žádná operace. 
Při práci se může zobrazit následující definice: 

• Null - žádná operace 

• Menu - kamera je v menu režimu 

• Sp 1 - kamera je v režimu bodové analýzy 

• SP 2, SP 3, SP 4, Area, Prof, Isot -další režimy analýz 

b) sekce - stav zobrazení scény živý obraz/pozastavený (zamrzlý).  

             Přepínat  je možné tlačítkem „S“. 

c) sekce - stav baterie 

d) sekce - datum 

e) sekce - čas 

f) sekce - pracovní teplota senzoru  
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6.1.7 Práce s menu 
Pokud není menu zobrazené, tlačítkem menu "↵" vyvoláte zobrazení hlavního menu. 

Směrovými tlačítky „L“ a „R“ zvolte skupinu a tlačítkem „-“ zobrazte její položky. 

Směrovými tlačítky „L“ a „R“ vyberte položku a výběr potvrďte tlačítkem menu "↵". Potom 
stlačte tlačítko „C“ – vraťte se zpět do výběru položky. 

Stlačením tlačítka „C“ se vraťte vždy do vyšší úrovně menu; po stlačení v nejvyšší úrovni 
se režim menu ukončí. 

6.1.8 Zaostření obrazu 
V režimu „Null“: zaměřte termokameru na cílový objekt a tlačítky „+“ a „-“ obraz zaostřete. 

Jestliže jste v jiném režimu než „Null“, tlačítkem „C“ tento režim opustíte a vrátíte se do 
režimu „Null“.  

Když je však potřebné uložit probíhající stav analýzy, stiskněte tlačítko „A“, kamera 
se přepne do „Null“ režimu. Potom tlačítky „+“ a „-“ obraz zaostřete. 

6.1.9 Vyvážení/nastavení obrazu 
V režimu „Null“ a nebo „Menu“ tlačítkem „A“ spustíte automatické vyvážení složek obrazu 

nastavených v „Setup→image“ volbách. 

V průběhu jiných režimů buď tlačítkem „C“ režim opustíte, nebo tlačítkem „A“ uložte 
aktuální stav analýzy. V obou případech se kamera vrátí do režimu „Null“. Potom tlačítkem „A“ 
spustíte automatické vyvážení složek obrazu. 

6.1.10 Pozastavení (zamrznutí) obrazu 
Při zobrazení živé scény se tlačítkem „S“ obraz pozastaví - zamrzne. Opětovným stlačením 

tlačítka se režim ukončí a vrátí se k živému zobrazení scény. Tato funkce je dostupná ve všech 
pracovních režimech. 

6.2 Nastavení kamery 

6.2.1 Parametry měření objektu  
Nastavení se provede v „Analysis→Obj. Par“ po potvrzení volby tlačítkem menu "↵" 

se v dolní části displeje zobrazí dialogové okno  s jednotlivými hodnotami parametrů měření. 
Tlačítky „L“ a „R“ nalistujte příslušný parametr a tlačítky „+“ a „-“ upravte jeho hodnotu pro 
dosažení co nejpřesnějšího měření. 

 

Je možné nastavit následující parametry: 

• Emiss = emisivita prostředí 

• Dist = vzdálenost měřeného objektu 

• Tamb = teplota pozadí 

• RelHum = relativní vlhkost 
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6.2.2 Automatické nastavení  
Volba „Image→Auto adjust“ aktivuje automatické nastavení úrovně teplotního rozsahu 

podle cílového objektu. Funkce se dá vyvolat i tlačítkem „A“ na ovládacím panelu. 

 

6.3 Typy analýz 
 

6.3.1 Lineární analýza 
• Lineární analýza získává z měřené oblasti hodnoty pouze o velikosti úsečky. Současně 

se zobrazuje i grafická křivka znázorňující hodnoty teplot na úsečce.  

• Vstupte do menu a zvolte „Setup→Analysis→Profile“ a zvolte buď horizontální, 
nebo vertikální polohu úsečky. 

• Potvrďte volbu „Analysis→Profile“ tlačítkem menu "↵" a spusťte tak samotnou analýzu. 
Zobrazí se úsečka s ukazovatelem v jejím středě. Teplota tohoto bodu je zobrazená v pravém 
dolním rohu displeje (za hodnotou je zobrazená zkratka „pt“). Současně se zobrazuje i grafická 
křivka znázorňující hodnoty teplot na úsečce. 

• Přesouvání úsečky. Úsečku je možné přesouvat pomocí směrových tlačítek „+“ a „-“ 
v případě horizontální a „L“ a „R“ v případě vertikální orientace. Graf se při přesunu aktualizuje. 

 

6.3.2 Zónová analýza 
• Zónová analýza měří teplotu z plochy kterou si nastavíte a zobrazuje též hodnoty, které 

požadujete (max. teplota, průměrná, minimální). Tyto hodnoty se vztahují pouze na vybranou 
plochu. 

• Vstupte do menu a zvolte „Setup→Analysis→Area function“ a zvolte jednu z hodnot 
zobrazované teploty v zóně: „Maximum“, „ Minimum“ nebo „Average“ (průměrnou). 

• Potvrďte volbu „Analysis→Area“ tlačítkem menu "↵ " a spustíte tak samotnou analýzu. 
Uprostřed snímku se zobrazí zelený obdélník ohraničující zónu měření. V pravém dolním rohu 
displeje se zobrazí teplota maximální, minimální anebo průměrná (podle aktuálního nastavení, 
za hodnotou je zobrazená příslušná zkratka „ah“, „ al“ nebo „aa“)  naměřená v dané zóně. 

 

• Změna polohy a velkosti zóny. Plochu zóny je možné přesouvat pomocí čtyř směrových 
tlačítek. Také je možné změnit její velkost současným stlačením dvou směrových tlačítek: 

o „+R“ - horizontální zvětšení 

o „-L“ - vertikální zvětšení 

o „-R“ - horizontální zmenšení 

o „-L“ - vertikální zmenšení 
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6.3.3 Izotermická analýza 
• Vstupte do menu a nastavte následující parametry měření: „Setup→Analysisv→lsotherm 

type“ - typ izotermy „Setup→Analysis→lsotherm width“ - rozsah intervalu izotermy. 

• Barva izotermy „Setup→Analysis→lsotherm colour“ potvrďte volbu 
„Analysis→isotherm“ tlačítkem menu „↵“ a spusťte tak samotnou analýzu. Zobrazí 
se zvýrazněný izotermický průběh ve zvolené barvě v závislosti na nastavených parametrech. 

• Změna izotermické zóny a její velikosti. Směrovými tlačítky „+“ a „-“ se mění hodnota 
mediánu (střední teploty) izotermického intervalu, tlačítky „R“ a „L“ opět v příslušném směru 
jeho teplotní rozsah. 

 

6.3.4 Zvětšení/zmenšení obrazu 
• Zvětšovat/zmenšovat obraz je možné jen v režimu „Null“. Pokud se v něm nenacházíte, 

použijte tlačítka „C“ nebo „A“ na návrat do tohoto režimu. 

• Zvětšení/zmenšení SH-68 / 6800 dokáže zvětšit infračervený obraz až ×3  oproti normálu. 
Každé stlačení tlačítka „R“ zvětší obraz o 10%, až po dosažení 300% velikosti. Naopak tlačítkem 
„L“ se obraz o 10% zmenšuje. Pokud stisknete toto tlačítko „L“ a obraz nebyl zvětšený, přejdete 
do 4-obrazového režimu (viz. níže). 

      Zvětšení/zmenšení obrazu nemá žádny vliv na výkon různých analýz. 

6.3.5 Čtyř-obrazový režim  
• Tato analýza je přístupná jen v režimu „Null“. Pokud se v něm nenacházíte, použijte 

tlačítka „C“ nebo „A“ na návrat do tohoto režimu. 

• Při zobrazení v originální velkosti stlačte tlačítko „L“ a přejděte do 4-obrazového režimu. 
Obrazovka se rozdělí na 4 části. V každé z nich  je možné nezávisle vykonávat různé obrazové 
funkce, jako jsou zamrznutí obrazu, zvětšení, automatické vyvážení. 

          Aktivní je vždy jen jeden ze snímků, navolit je ho možno směrovými tlačítky „+“ a „-“       
Na něj je možno aplikovat výše uvedené funkce. Tento režim nemá vliv na různé celo-
obrazovkové analýzy. Jeho stav je možné uchovat. 
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6.4 Práce se snímky 

6.4.1 Uložení snímku 
• Ukládání snímků vstupte do menu, zvolte „File→Save“ a potvrďte tlačítkem menu. 

Aktuálně zobrazený snímek se uloží na paměťovou kartu. Operace je dostupná při živém 
zobrazení i při pozastaveném snímku, v termokameře musí byt vložená paměťová karta. Operaci 
je možné vyvolat i delším přidržením tlačítka „S“. 

• Záznam hlasové poznámky. Před záznamem hlasové poznámky připojte ke kameře 
sluchátka s mikrofonem a pozastavte obraz (tlačítkem „S“), případně otevřete uložený snímek 
volbou „File→Open“. Potom vstupte do menu, zvolte „File→Voice rec“ a potvrďte tlačítkem 
menu. Uprostřed displeje se vypíše text „Recording voice“ a začne se nahrávat slovní komentář 
v max. délce 8 sekund. Poznámka se uloží spolu se snímkem. Volbou menu „File→Voice play“ 
je možné poznámku opakovaně přehrát. 

 

6.4.2 Práce s uloženými snímky 
• Otevření snímku. Vstupte do menu, zvolte „File→Open“ a potvrďte tlačítkem menu. 

Termokamera za krátkou dobu načte obsah paměťové karty, zobrazí názvy souborů se snímky 
a jejich celkový počet. Směrovými tlačítky „+“ a „-“ nalistujte vybraný soubor se snímkem 
a výběr potvrďte tlačítkem menu „↵“. Uložený snímek se zobrazí. Tlačítky „R“ a „L“ můžete 
přímo otevřít a zobrazit další resp. předešlý snímek v pořadí. 

• Vymazání snímku. Vstupte do menu, zvolte „File→Delete“ a potvrďte tlačítkem menu. 
Podobně jak při otevření snímku, za krátkou dobu se načte obsah paměťové karty, zobrazí 
se názvy souborů a jejich celkový počet. Po potvrzení tlačítkem menu se zvolený soubor vymaže. 

• Změna barevné palety. Vstupte do menu, zvolte „Setup→image→Color Scale“ a změňte 
barevnou paletu tlačítky „+“ a „-“. Změna se okamžitě aplikuje na zobrazený snímek. Navíc 
tlačítky „R“ a „L“ můžete přímo zobrazit další resp. předešlý snímek v pořadí.[3] 

 

6.4.3 Další možnosti práce se snímky 
 

Se snímky lze dále pracovat a upravovat je v programu SRS Obr.6.2: Tento program nabízí 
celou řadu funkcí, od změny barevné palety přes změnu analýzy, zjištění teploty v konkrétním  
bodě nebo zóně, nastavení intervalu izotermy  Obr.6.3: až po grafické znázornění naměřených 
hodnot v několika typech grafů.  

 

 

 

 

 



ÚSTAV VÝKONOVÉ ELEKTROTECHNIKY A ELEKTRONIKY 
Fakulta elektrotechniky a komunikačních technologií 

Vysoké učení technické v Brně 

    
 28 

 

 

 

 

Obr. 6.2: Program SatReport Standard 

 

 

 

 

Obr. 6.3: Izotermická analýza v programu SRS 
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7 APLIKA ČNÍ MOŽNOSTI TERMOVIZE V 

ELEKTROTECHNICE  
 

7.1 Energetika 
Ve smyslu platné legislativy provozovatel distribuční soustavy má povinnost zabezpečit 

spolehlivý a bezpečný chod soustavy. 

Pravidelné kontroly a vykonávání údržby, diagnostiky a monitoringu energetických 
distribučních zařízení má nejen bezpečnostní význam, ale i významný ekonomický efekt. 
U některých poznatků kontroly a vyhodnocení naměřených údajů (špatný proudový spoj) 
je možné předpokládat výpadek VVN nebo VN zařízení až na několik hodin. Poruchový stav 
těchto zařízení má velký dopad i na ekonomiku jiných sekundárně závislých odběratelů. Poruchy 
mohou být v různém rozsahu škod, případně mohou souviset s ekonomikou celé země. 

Pravidelné kontroly a zkoušky můžeme rozdělit do dvou okruhů. 

Kontroly a zkoušky vykonávané na el. zařízeních pod napětím a kontroly a zkoušky 
vykonávané bez napětí.  

Kontroly vykonávané za provozu, tj. pod napětím, se v minulosti vykonávali především jako 
zrakové prohlídky - kontrola vykonávaná pohledem, při které zodpovědný pracovník vizuální 
prohlídkou kontroluje určené zařízení, případně jako měření el. veličin - napětí, proud, odpor 
impedančního uzlu, odpor uzemnění zemniče apod. V tomto případě byl výsledek a kvalita 
kontroly přímo ovlivněná lidským faktorem. 

V současnosti se však stále zvyšuje podíl kontrol vykonávaných diagnostickými 
bezkontaktními nedestruktivními metodami, mezi kterými dominuje metoda využívající 
infračervené záření. 

Výhodou kontrol vykonávaných pod napětím oproti těm, které se vykonávají bez napětí je, 
že se neomezí dodávka elektrické energie k spotřebitelům. 

Termovizní měření využívá tedy výrobce elektrické energie jako prostředek na identifikování 
a hledání problémových oblastí při přenose a distribuci elektrické energie. Další výhodou je, 
že pomocí termovize můžeme rozpoznat poruchu již v počátečním stadiu, což se opět promítne 
v ekonomice oprav spojených s touto poruchou. Při měření na elektrických zařízeních se snímá 
infračervené záření vyzařované z oblasti nedokonalého spojení dvou vodičů, kterými protéká 
elektrický proud. Hlavním kritériem pro rozhodnutí, zda jde o nedokonalý spoj, není pouze 
absolutní teplota spoje, ale zejména teplotní rozdíl oproti ostatním spojům, případně jeho rostoucí 
trend. Měřením, postupným sledováním a porovnáním s archivovanými hodnotami je možné 
rozhodnout o kvalitě sledovaného spoje. Špičkové technické vybavení umožňuje informovat 
provozovatele přímo na místě o zjištěné poruše a její závažnosti. 
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7.2  Kontrola VVN, VN p řenosových vedení, strojů a přístrojů 
 

Kontrola stavu venkovních rozvodů vedení VVN a ZVN se provádí z vrtulníku, ve kterém 
bývá termovizní technika většinou zabudovaná. Postupně se letí podél vedení ve vzdálenosti 10-
20 m s převýšením 5-10 m podle daných možností rychlostí 50-80 km/hod. Metoda je rychlá 
a efektivní, přičemž pomocí termovize se kontroluje vedení a zjišťuje se, jestli jsou jednotlivé 
spojovací prvky oteplené. Kontrola potenciálních poruchových míst na vzdušných vedeních 
přenosové a distribuční soustavy (vedení kV400110− ), jejíž délky jsou několik set kilometrů, 
se bez využití vrtulníku a termovizní kamery nedá efektivněji a kvalitněji realizovat. 

Při venkovních rozvodech se při měření provádí korekce na momentální atmosférické 
podmínky. Výsledný vyhodnocený údaj oteplení se potom (podle jeho velikosti) na základě 
termogramu klasifikuje do klasifikačních stupňů a pro každý stupeň jsou doporučené stupně 
opatření. 

Kontrola elektrických strojů a přístrojů 

Pravidelnou diagnostikou a včasným odhalením malých poruch (poruchy v počátečním 
stádiu) předcházíme opravám velkého rozsahu (např. včasná výměna ložiska předchází jeho 
shoření nebo havárii elektromotoru, ventilátoru apod.). 

U elektrických strojů a generátorů se pomocí termovize kontroluje velmi často i magnetický 
obvod. Například při odstaveném stroji (vyjmutý rotor) je navinuté okolo statoru magnetizační 
vinutí. Při zatížení tohoto vinutí se nasycuje magnetický obvod stroje. V případě, že mezi 
jednotlivými plechy, ze kterých je magnetický obvod složen, jsou ztráty, dochází k oteplování, 
které můžeme termovizní kamerou velmi dobře změřit. Tyto ztráty nejsou ani tak nebezpečné 
pro vlastní plechy, jako pro izolaci statorového vinutí, které tak může být nepřiměřeně namáhané. 
Důsledkem velmi často bývá poškození a v návaznosti na to i havárie stroje.    

 

 

 

Obr. 7.1: Kontrola oteplení pláště transformátoru 
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Při kontrole transformátoru se kontroluje, zda nedochází k oteplení jeho určitých částí 
Obr.7.1: Kontrolují se průchodky transformátoru, rozložení tepelného pole na nádobách 
olejových transformátorů apod.  

Termovizní technika nachází široké uplatnění při kontrole elektrických strojů a přístrojů, 
jako je např. zjišťování teploty na sběrných ústrojích a budících soustavách generátorů, silových 
částí elektrických strojů, zjišťování teplotních rozdílů na polovodičových ventilech 
v jednotlivých paralelních větvích zařízení apod. Jinak řečeno všude tam, kde fyzikální veličina 
teplota nám vypovídá o stavu daného zařízení nebo některé z jeho částí. 

7.3  Telekomunikace 
Pro správnou činnost vysílačů mimo obnovy a rekonstrukce je stejně důležitá i údržba 

(údržba samotných anténových systémů a jejich nosičů). Poměrně složité anténové systémy jsou 
velmi citlivé na zvětšení přechodových odporů dílčích anténových uzlů. Zvětšením přechodových 
odporů klesá emitovaný výkon vysílače a na přechodech vznikají tepelné ztráty. Pro optimální 
chod systému jsou potřebné pravidelné revizní kontroly, které jsou poměrně časově i finančně 
náročné, protože se převážně jedná o práci ve výškách. Právě využitím termovize se práce 
výrazně zrychlila a zkrátila, čímž se snížily finanční náklady. Při kontrole takovýchto zařízení 
se kontrolují zejména napájecí rozvody antény, vlastní anténa, údržba fázovače apod.  

Měření anténových systémů je vhodné realizovat na jaře a na podzim, přičemž je třeba 
respektovat stupně oteplení a příslušné opatření vzhledem na bezporuchovou činnost vysílacích 
středisek. 

7.4  Stavebnictví 
I v důsledku neustálého nárůstu cen energie se klade důraz na efektivní využití nákladů 

vynaložených na energii. Pokud chceme zabránit nežádoucím únikům energie, musíme nejprve 
lokalizovat místa a příčiny vzniku ztrát. Jedna z metod zabývající se úniky tepelné energie 
je termovize. Účelem většiny termovizních měření v stavebnictví je stanovení rozložení 
povrchových teplot na plášti budovy a zjištění, jestli toto rozložení povrchové teploty 
je netypické, tj. jestli je způsobené např. chybným provedením stavebních prací, poruchami 
izolace,netěsnosti oken a dveří, kondenzací vlhkosti apod. 

 Nachází využití hlavně při kontrolách zjišťování míst tepelných ztrát budov jako podklad 
pro projektování izolace, kvality provedených prací při kolaudaci, vyhledávání poruch 
podlahového vytápění, technologického vybavení budov, vyhledávání prasklin v plášti budov viz. 
Obr.7.2: 

Na základě termovizních měření doplněných o tepelně-technické výpočty je možné 
realizovat návrh na dodatečné zateplení jak z hlediska tloušťky tepelné izolace, tak z hlediska 
rozsahu zateplení. Při dnešní ceně energie vynaložené na vytápění daného objektu se předpokládá 
při stavbě úspora 15-35%. Při zateplení průměrného rodinného domu je návratnost vynaložených 
nákladů 6 až 10 let. 

Proto se v poslední době poměrně často objevují odborné publikace, zabývající 
se odhalováním nedostatků v provedení tepelné izolace, které způsobují tzv. tepelné mosty 
(zjišťují se termokamerou). Jedná se vlastně o spojení vnitřní stěny s venkovním povrchem pláště  
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budovy tepelně vodivým materiálem nebo kombinací několika materiálů. Zvyšování důrazu 
na tepelné mosty je dané také tím, že při realizaci staveb s relativně málo účinnými tepelnými 
izolacemi tvořili tepelné ztráty tepelnými mosty malé procento veškerých ztrát. Pokud je však 
stavba tepelně izolovaná vysoce účinnou izolací, potom se každý tepelný most, kterým uniká 
teplo, stává významnou „dírou“ do tepelného obalu budovy. V praxi se tepelné mosty projevují 
chladnějším místem v interiéru nebo naopak teplejším místem v exteriéru, pokud je samozřejmě 
interiér teplejší než exteriér. 

Právě proto, jak už bylo zmiňováno, je možné mapovat tepelné mosty termokamerou. 
Je možné získat okamžitou představu, kde se vyskytuje anomálie, a jak je velká, případně jaký 
má tvar. Je třeba upozornit, že použití infrakamery má svoje pravidla a výsledky měření 
neprovedeného odborníkem pro práci s tímto zařízením mohou vést k velkým omylům 
při měření. 

Termografická měření se normálně vykonávají v jedné nebo dvou etapách. Měření 
na nezateplených objektech a měření na objektech po zateplení.  

Pro zjištění co nejlepších výsledků měření tepelně-izolačních vlastností objektu se 
doporučuje rozdíl mezi teplotou vzduchu uvnitř a teplotou venkovní rozdíl alespoň 15° C. 
Nejlepší podmínky pak nastávají, když je venkovní teplota kolem nuly. Měření nesmí být 
ovlivňované přímým slunečním světlem ani větrem. Proto je nejlepší měřit při bezvětří před 
východem slunce slunce. 

 

 

 

 

 

Obr. 7.2: Rozložení teploty na povrchu pláště budovy 
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7.5  Teplovodné parovodné systémy 
 Teplovodné rozvody, jak místní tak dálkové, nejsou všechny ve stavu, který by zajišťoval 

přenos tepelné energie s minimálními ztrátami. Hlavně místní tepelné podzemní sítě jsou 
nedostatečně izolované nebo mívají dokonce poškozené či přímo děravé kondenzátní vratné 
větve. Teplota vody-páry při výstupu je např. 90-100 °C, při návratu do teplárny je v rozsahu 40-
70 °C a znovu se ohřívá. Životnost takového systému se odhaduje na 30-35 roků. Důsledek toho 
je zvýšení požadavků na denní údržbu a opravy. U již postavených zařízení se vyskytuje 
opotřebení starých rour a izolací. Přitom od dodavatele tepla se vyžaduje bezpečná dodávka 
a optimalizace zdrojů za účelem co nejmenších nákladů na přenos energie. 

 Z toho všeho vyplývá potřeba vhodných a hlavně dostupných metod revize. Právě jednou 
z nich je použití termovize. Pomocí termovize je možné zaměřovat a identifikovat poruchová 
místa u podzemních teplovodních sítí, kontrolovat stav izolace u podzemních i nadzemních 
teplovodných  sítí nebo kontrolovat bezkanálové teplovodné sítě, u kterých je třeba respektovat 
i hledisko bezpečnosti. Sledování stavu teplovodních sítí se provádí nepřetržitě a závisí 
na konstrukci daného teplovodního systému. Termovize využívá skutečnosti, že při tepelném 
úniku vlivem trhlinky v potrubí nebo při ztrátách tepla v důsledku vlhké izolace dochází 
k velkým tepelným ztrátám, které se projeví lokálním zvýšením teploty povrchu v okolí 
poškozeného místa. Teplovodné rozdíly na povrchu jsou tím větší, čím je větší tepelný únik. 
Podle velikosti rozdílu v místě se zvýšenou teplotou a teplotou nepoškozené části teplovodu 
se určuje rozsah poškození. Pravidelná revize má zásadní vliv na ekonomii provozu zařízení, jako 
i na možnost optimálního plánování oprav.   

7.6  Medicína 
Využití termovize v medicíně je založené na předpokladu, že nemocí postižené místo vydává 

jiné množství tepla než okolní zdravá tkáň. Na termogramu se to projeví změnou v rozdělení 
teploty tělesného povrchu, což je možné hodnotit jako příznak onemocnění. Na mapování 
rozdělení teploty tělesného povrchu je možné použít metody kontaktní (přímé) a bezkontaktní 
(nepřímé, elektronické). Spektrum infračerveného záření závisí na teplotě vyzařujícího tělesa a 
jeho okolí. Infračervené záření, které se vyzařuje z povrchu lidského organismu, má vlnovou 

délku v rozmezí 6101 −⋅ až m3101 −⋅  a energii 1 až Ve⋅⋅ −3101 . Na jeho detekci se používají 
přístroje, které transformují vyzářenou tepelnou energii na obraz rozdělení povrchové teploty 
zkoumaného objektu. Nejrozšířenější jsou termovizní zařízení. 

Termografie jako jedna z diagnostických metod je rozšířená už v mnoha zemích světa pro 
tzv. vědecko-výzkumnou práci, ale v některých zemích se prosazuje jako jedna z vyšetřovacích 
metod. Její diagnostická schopnost se postupným vývojem přístrojů neustále zlepšuje, 
ale i naproti tomu se zatím pohybuje okolo 75%. V její prospěch hovoří neinvazivnost, 
jednoduchost, absolutní bezpečnost pro pacienta i obsluhu, jako i poměrně nízká cena vyšetření. 
Proto je poměrně oblíbenou metodou při cévních onemocněních, nemocí kůže, očí, revmatických 
onemocněních kloubů, ale i jako doplňková metoda v diagnostice onemocnění štítné žlázy, 
při vyhledávání metastáz atd. Termografie je vhodná i na sledování úspěšnosti léčebného 
postupu, nebo jako rychlá a přehledná diagnostika na letišti při riziku šíření epidemie (pandemie) 
Obr.7.3:  apod. 
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Pomocí termovize je možné odhalit ložiskové chorobné procesy, což závisí na rozdílu teploty 
ložiska a okolní zdravé tkáně. Nejširší uplatnění má však při hledání nemocných stavů cévního 
řečiště, zejména prokrvení horních a dolních končetin. 

Termovize poskytuje možnosti uplatnění např. i při rychlé neinvazivní veterinární 
diagnostice. 

 

Obr. 7.3: Letištní kontrola 

 

7.7 Ekologie 
V poslední době se začíná termovize používat v této v současnosti aktuální oblasti, za účelem 

získání takových informací, na základě kterých můžeme vytvářet podmínky pro zlepšení stavu 
životního prostředí. 

 Termovizní systém bývá zabudovaný do vrtulníku nebo letadla a používá se na snímání 
a následné vyhodnocování tepelných obrazů ve vybraných lokalitách, regionech a oblastech, 
kde při měření v určité době je možné získat poznatky o mikroklimatu. Měření se doporučuje 
realizovat v létě, v teplém a slunečném počasí (měření se realizuje v nočních hodinách), přičemž 
získáme informace o naakumulování a odevzdání tepelné energie různými objekty, ale i částmi 
terénu. Po vyhodnocení se může následně regulovat tepelná zátěž (např. vysázením porostu). 

Dále je možné s pomocí termokamery diagnostikovat, jestli se ve vodních nádržích netvoří 
místa se zvýšenou teplotou v důsledku nedostatečného proudění vody, která tvoří nebezpečí 
pro živočichy, rostliny apod.  

7.8  Další odvětví průmyslu 
Měření povrchové teploty tělesa na celém povrchu současně a zobrazení takového teplotního 

pole se uplatní např. v slévárenství, při tepelném zpracování výrobků, při optimalizaci 
konstrukce, při diagnostice chodu strojů, při požární prevenci. Termovizní diagnostikou je možné 
odhalit všechny kritické místa, v kterých vlivem nesprávného a poruchového chodu dochází 
k zahřívání a tedy i k zvyšování teploty. 
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Můžeme ji aplikovat všude tam, kde na základě fyzikální veličiny jako je teplota je možné 
charakterizovat technický stav daného zařízení, materiálu apod. Termovizní systémy se používají 
i v sledování takových objektů, kde je důležitá ochrana před vznikem požáru např. skladiště 
pneumatik, uhlí apod. s rizikem jejich vznícení. 

 

7.9 Speciální aplikace 
Další významná oblast využití termovizních kamer je v bezpečnostních aplikacích, které 

zahrnují jak vojenské, tak civilní účely. Pro svoje přednosti se využívá např. k průzkumným 
účelům v každé moderní armádě. Poskytuje reálný obraz bojiště, který může být přímo vizuálně 
sledovaný, zaznamenávaný, případně přenášený rádiem na příslušná místa velení k dalšímu 
využití. 

Pozemní bezpečnostní systémy jsou tedy významnou oblastí, pro kterou výrobce nabízí 
soubor speciálních výrobků a to přenosných, pevně zabudovaných a dále systémů určených 
pro kontrolu pozemních zařízení. 

Termovizní kamery mají tu výhodu, že mohou pracovat i při snížené viditelnosti (např. mlha) 
a při nulových světelných podmínkách. Princip snímací scény, založený na detekci tepelného 
záření, umožňuje zviditelnit osobu i za tenkými překážkami. Příčinou je velmi dobré kontrastní 
vidění i v úplné tmě. 

Samozřejmě, že můžeme použít i termovizní kamery určené pro komerční účely, ale některé 
z nich jsou přímo konstruované pro použití v bezpečnostních aplikacích. Zvlášť vhodné je použití 
stacionárních kamer pro trvalé sledování důležitých objektů s nepovoleným vstupem do nich. 
V posledních letech se objevují nové vylepšené systémy, které umožňují rozlišit minimální 
teplotní rozdíl. 

V současnosti se termovize stává důležitou součástí zabezpečení ochrany objektů a majetku 
firem, sledování pohybu techniky, ale i k sledování pohybu osob či vozidel. Je možné ji využít 
v kriminalistice, umí potvrdit manipulaci s vozidlem ještě několik hodin po jeho jízdě Obr.7.4: 
apod. Díky tomu, že je možné ji propojit s elektronickou zabezpečovací signalizací, můžeme 
znásobit ochranu hlídaného objektu. Obsluha takovéhoto objektu získává tímto propojením nejen 
informaci o narušení objektu, ale i možnost si celou situaci zpětně prohlédnout.  

 

Obr. 7.4: Rozložení teploty povrchu spalovacího motoru 
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8 MĚŘENÍ TERMOKAMEROU  

8.1  Měřený spínací přístroj 
Pro praktickou ukázku měření jsem proměřil vysokonapěťový odpínač venkovního vedení 

od firmy IVEP, a.s. Odpínač patří do skupiny el. přístrojů provozních, je to venkovní spínací 
přístroj sloužící k vypínání a odpojování úseků sítí VN. Provedení odpínačů je umožňuje využít 
pro práci pod napětím. Odpínač musí umět zapnout do zkratu a zkratový proud bez poškození 
přenést. Jsou vybaveny zhášecím zařízením a slouží ke spínání obvodů pod proudem, tzn. mohou 
zapínat a vypínat provozní proudy až do velikosti jmenovitého proudu. Upevnění odpínače 
je vidět na Obr.8.1:. Proudovodnou dráhu měřeného přístroje tvoří součásti z galvanicky 
postříbřené mědi. Kontaktní pružiny, čepy, šrouby a ostatní spojovací součásti v proudovodné 
dráze, včetně pérových pojistných podložek a jednoho opalovacího růžku jsou z korozivzdorné 
oceli. Izolátory jsou silikonové (epoxidové). [5] Na odpojovači Obr.8.2.a): jsem měřil za pomocí 
termokamery, termočlánku a dotykového teploměru teplotu na dvou typech materiálů a to na 
korozivzdorné oceli Obr.8.2.b): a galvanicky postříbřené mědi Obr.8.2.c):. Měření bylo 
prováděno za nastavení konstantní hodnoty emisivity v kameře. 

 

 

Obr. 8.1: Upevnění odpínače na sloupu 
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Obr. 8.2. a): Odpínač VN, b): korozivzdorná ocel, c): postříbřená měď 

 

 

 

8.2   Zjištění hodnoty teploty části přístroje z infračerveného 
snímku pomocí programu SRS 

 

Po spuštění programu SRS  je třeba označit ikonu kamery (Ir Image) Obr.8.3: 
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Obr. 8.3: Program Sat report Strandard 

Kliknutím levým tlačítkem myši na „pracovní plochu“ se zobrazí obrázek s teplotní stupnicí 
Obr.8.4: 

 

 

Obr. 8.4: Obrázek s teplotní stupnicí 
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Kliknutím pravým tlačítkem na tento obrázek se zobrazí nabídka Obr.8.5. b): pomocí níž 
se nejprve vloží infračervený snímek ve formátu SAT z kamery. 

Poté se v levé liště vybere vhodná analýza, která se umístí levým tlačítkem do obrázku, 
na výběr je buď bodová, zónová, lineární nebo kruhová. 

Pravým tlačítkem se opět vyvolá nabídka a tentokrát je třeba označit tlačítko Setting 
pro nastavení parametrů. V okně IR se nastaví parametry které byly použity u měření Obr.8.5. a): 
(emisivita, vzdálenost, teplota okolí, relativní vlhkost). 

 

V okně Analysis  se označí analýza pro nastavení. Zatrhne se parametr Own Parameter, 
v Analysis – Label se nastaví typ teploty která bude zobrazena  Obr.8.6:  (max., min., prům.)  

 

 

 

 

 

 

 

Obr. 8.5: Nastavení parametrů měření 

  

a.) b.) 
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Obr. 8.6: Nastavení parametrů bodové analýzy 

 

 

 

 

Obr. 8.7: Možnosti využití analýz 

 

 

Potvrzení volby tlačítkem OK. Na pracovní ploše se objeví vložený infračervený snímek 
a na něm je patrná hodnota teploty pro nastavenou část materiálu.  Nyní je možné analýzu použít 
na všechny snímky z měření bez opětovného nastavování. Je nutné nastavit pro každý snímek 
parametry, při kterých byl měřen. 
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8.3  Zjišt ění emisivity materiálu z programu SRS  
První předpoklad, díky kterému lze určit správnou hodnotu emisivity materiálu v programu 

SRS je znalost jeho teploty v době pořízení snímku kamerou. Protože jsem při měření odečítal 
teplotu ze dvou přístrojů a to termočlánku (připojeného na měřící přístroj Hexagon) a dotykového 
teploměru (FLUKE), jako referenční hodnotu pro výpočty jsem uvažoval hodnoty termočlánku. 
Jelikož kontakt termočlánku byl přilepen k měřenému objektu, měnila se teplota „teplého konce“ 
termočlánku společně s měřeným objektem a nedocházelo tam tedy ke dvěma nejistotám navíc, 
způsobených u dotykového teploměru jednak rozdílem teplot styčných ploch a dále 
nerovnoměrnou dobou měření a přítlačnou silou, která nebyla při měření konstantní.  

Poté, co je k dispozici teplota materiálu a jeho infračervený snímek pořízený ve stejný 
okamžik, je možné zjistit hodnotu emisivity v programu SRS. Postup je prakticky stejný jako u 
zjišťování teploty v programu SRS, s tím rozdílem, že se v kolonce EMS  (Obr.8.6:) nastaví 
hodnota emisivity a program přepočítá výslednou teplotu. Pokud teplota referenční a teplota ze 
snímku jsou shodné, nastavená emisivita odpovídá emisivitě materiálu. 

8.4  Výsledky měření 
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Obr. 8.8: Naměřené hodnoty teplot při oteplování 

 

 

Jak je patrné z Obr.8.8: oba dotykové teploměry mají podobné průběhy charakteristik rozdíl 
teploty dotykového teploměru FLUKE oproti termočlánku, který činí cca 5°C je způsoben  
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offsetem měřícího přístroje (posunutí nuly naměřené hodnoty). Pokud porovnáme referenční 
průběh teploty s teplotou odečtenou z infračerveného snímku pořízeného kamerou je patné, 
že nemají stejný průběh. Důvodem je, že měření bylo prováděno s konstantní hodnotou emisivity 

9,0=ε .  
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Obr. 8.9: Naměřené hodnoty teplot při ochlazování 

 

Stejně jako u prvního měření, tak i u měření mědi se rozdíl teplot dotykových teploměrů 
pohyboval okolo cca 5°C, také teplotní charakteristika naměřená termokamerou neodpovídala 
charakteristice referenční viz Obr.8.9:. 

 

 

 

8.4.1  Korozivzdorná ocel 
Popis materiálu: 

Jak je patrné z Obr.8.2.b):  tento materiál je velmi lesklý, navíc byl k ose měření v poloze 
která je zobrazena na Obr.8.10:. Na infračerveném snímku jsem provedl v programu SRS lineární 
analýzu zobrazené délky měřeného objektu, která vypovídá o závislosti zobrazené teploty 
na tvaru objektu, tedy na úhlu vyzařování tělesa. Její grafické vyjádření je na Obr.8.11.b):    
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Jak je patrné z infračerveného snímku Obr.8.11.a):, je oblast s vyšší teplotou situována 
na ploše, která je prakticky kolmá k ose snímání termokamery. Teplotní interval měřeného 
materiálu je od cca 18°C až do 29°C. Je však zřejmé a měřením potvrzené, že teplota materiálu 
zobrazeného na snímku je v celém povrchu prakticky stejná. Na velkém rozdílu teplot (cca 
∆T=11°C) má vliv hodnota emisivity, která je závislá na povrchu materiálu a na jeho zakřivení, 
neboli úhlu vyzařování tělesa. Měřený materiál vytváří podmínky nevhodné pro termovizní 
diagnostiku.   

  

 

Obr. 8.10: Poloha materiálu při snímání termokamerou 

 

 

 

 

Obr. 8.11: Vliv tvaru materiálu na teplotu měřenou termokamerou 
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Obr. 8.12: Různé hodnoty emisivit v porovnání s reálnou teplotou (materiál ocel)  

Při dosazení různých hodnot emisivit v programu SRS Obr.8.12: je možné pozorovat, 
že žádná z dosazených emisivit (ani průměrná 432,0=ε ), neumožní dosáhnout přesných 

výsledků. Rozdíl teplot u referenční teploty a teploty, odečtené z termokamery při nastavení 
průměrné emisivity, je sice ze všech ostatních průběhů nejmenší, ale vůči referenční teplotě se 
pohybuje jak v kladných tak v záporných hodnotách. To, jak nelineárně se emisivita mění 
v závislosti na teplotě, je zobrazeno na Obr.8.13:. Na tomto obrázku je možné si povšimnout, že 
v intervalu nižších teplot (cca 20-37°C) jsou hodnoty teploty naměřené kamerou větší než u 
referenčních hodnot. Také hodnota vypočítané emisivity pro první měření (za studena) byla větší 
než 1. To je způsobeno vlivem teploty lidského těla, které má průměrnou teplotu 36,7°C. Tento 
parazitní tepelný tok se od reflexního materiálu odráží také směrem k ose snímání a zvýší 
tak celkovou hodnotu tepelného toku. To se projeví právě relativně vyšší zobrazenou teplotou 
měřeného materiálu. U vyšších teplot se tento jev také vyskytuje, ale již nezpůsobuje tak zásadní 
chyby měření. Těmto chybám je v praxi možné zabránit absencí obsluhy u měřeného objektu. 
Pokud je přítomnost obsluhy nezbytná, je možné použít vhodnou kombinézu, jenž spolehlivě 
odstíní tepelný tok, který všechny části lidského těla vyzařují. 
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Obr. 8.13: Závislost emisivity na teplotě při oteplování (materiál ocel) 

 

 

8.4.2 Postříbřená měď 
Popis materiálu: 

Materiál zobrazený na  Obr.8.2.c): je oproti předcházejícímu méně lesklý a měřená plocha 
je kolmá k ose snímání. Z toho také plyne, že zobrazená teplota na měřené části odpojovače byla 
na celé ploše přibližně stejná. Naměřená emisivita byla také v porovnání s ocelí nižší. 
Na Obr.8.14: je opět zobrazená charakteristika různých hodnot emisivit v porovnání s referenční 
teplotou. I u tohoto typu materiálu žádná z nastavených konstantních emisivit nemá podobný 
průběh jako referenční. Opět platí, že nejmenších rozdílů teplot dosahuje průměrná hodnota 
emisivity ( 161,0=ε ), její průběh je však oproti ostatním hodnotám emisivit nejméně podobný 

referenčnímu. Závislost emisivity na teplotě je zobrazena na Obr.8.15: její průběh je opět 
nelineární. 
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Obr. 8.14: Různé hodnoty emisivity v porovnání s reálnou teplotou (materiál měď) 
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Obr. 8.15: Závislost emisivity na teplotě při ochlazování (materiál měď) 
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8.4.3  Shrnutí 
U obou měřených materiálů se absolutní teplota od teploty naměřené kamerou velmi lišila, 

Pokud by se při vyhodnocování měření nebral v úvahu zásadní vliv emisivity materiálu 
na teplotu, lehce by se došlo k chybným výsledkům měření. Proto měření oteplování 
a ochlazování jakýchkoliv materiálů termokamerou je nutné provádět v kombinaci s dotykovým 
měřením, jak to ukládá norma ČSN EN 60947-1. 

 Dále je při měření dobré dodržovat určitý postup aby byly výsledky co nejméně zkreslené: 

1. Před měřením analyzovat měřený objekt.  

2. Co nejpřesněji nastavit parametry měření. 

3. Pokud je to možné, zajistit aby byla měřená plocha kolmo k ose snímání.  

4. Zajistit aby měření probíhalo bez nežádoucích stavů atmosféry mezi kamerou a měřeným 
objektem (vysoká vlhkost, mlha apod.). 

5. Vyvarovat se působení odrazu slunečního záření a jiných teplotních zdrojů od měřeného 
objektu, včetně teploty lidského těla. 

6. Pokud je to možné, je vhodné u lesklých materiálů, měřené místo začernit sazemi nebo 
přelepit teplovodnou páskou. 
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9 ZÁVĚR 
Cílem bakalářské práce bylo získat potřebné informace k problematice bezdotykového 

měření teploty a seznámit se s termokamerou jako s prostředkem pro bezdotykové měření. 
V první části práce jsem se zabýval teplotou, základními pojmy v oblasti měření teplot 
a bezdotykovém měřením, jehož převážná část je věnována právě termoviznímu způsobu měření. 

Další část práce je věnována termokameře SH-68 / HY-6800. V této části je popsána její 
funkční vybavenost. Jedná se převážně o typy analýz, které je schopna provádět, s jejich stručnou 
charakteristikou. Dále je zde zpracován stručný manuál pro práci s ní. V další části jsem 
zmapoval současné možnosti aplikačního využití termokamery. Je zde vypsáno několik možností 
jejího využití, společně s postupem měření a výhodami, které měření termokamerou v dané 
aplikaci přináší. 

V poslední části jsem teoretické poznatky využil k praktickému měření. Měření, které 
je zpracováno v kapitole 8, po přípravě pracoviště, nastavení a zaostření kamery probíhalo rychle 
a pohodlně. Pro porovnání výsledků jsem teplotu materiálů měřil termočlánkem a dotykovým 
teploměrem. Při zpracování jsem se zaměřil na hodnoty emisivit dvou typů materiálů, které 
se běžně v praxi požívají. U obou typů materiálů emisivita není konstantní, vliv u obou materiálů 
na hodnotu emisivity měla zejména měnící se teplota a povrchové vlastnosti materiálů. U oceli 
měl na teplotu vliv také úhel vyzařování, který nebyl na celé měřené ploše stejný. Obecně lze 
z Obr.8.13: a 8.15: usoudit, že se zvyšující se teplotou se hodnota emisivity u těchto materiálů 
zmenšovala. Její průběh však byl nelineární a z tohoto důvodu nelze provádět přesné měření 
absolutní teploty termokamerou bez současného měření teploty termočlánkem.  

Závěrem lze tedy konstatovat že, měření termokamerou, je co se týče srovnávacího měření 
stejných typů materiálů, případně rozložení teplotního pole objektu s homogenním materiálem 
v současné době bezkonkurenční jak z pozice rychlosti a jednoduchosti měření, tak co se týče 
zpracování výsledků měření a její přesnosti. Přes svoje nesporné výhody však tento způsob 
měření zejména díky vlivu emisivity nelze, bez použití termočlánku, použít pro přesné zjištění 
absolutní hodnoty teploty, případně rozložení teploty povrchu tělesa složeného z různých typů 
materiálů, nebo s různou povrchovou úpravou. To platí i pro srovnávací měření. 
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